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Installation
Specified Operating Environment

Minimum System Requirements

• Macintosh System Mac OS X (10.1 or later recommended)

• Any Macintosh computer (including iMacs and iBooks)
with G3-233 MHz processor or faster

• 128 MB RAM

• 104 MB free hard disk space

• Color monitor, 800 x 600 (1024 x 768 recommended)

• CD-ROM drive

For Online Access

• 8 MB additional free hard disk space

• Internet connection

Installation

Note: To install World Book, you need either to be the only
user set up on your computer or to have administrator
privileges. World Book installs components into shared
folders which can be accessed only by a user who is also an
administrator.

Step 1: Place Disc 1 in the CD-ROM drive (Disc 2 is not used
during installation).

Step 2: Locate the World Book Installer on Disc 1 and double-
click it to begin installation.

Step 3: Click Continue in the World Book screen that
appears.

Step 4: A navigation window will open to the main
Applications folder, which is the recommended location for
installation. Click Choose to install World Book in the
Applications folder or navigate to a different location.

Step 5: A window will appear indicating that the installation
was successful. Click Quit to close the window.

Starting the Program

Open the folder containing World Book. Double-click the
World Book icon. The first time you launch the application
you will see the License Agreement dialog. Click  Agree or
Disagree in the License window.

Note: You must view and agree to the License Agreement to
use World Book.

Registration

Registering your World Book makes you eligible to receive
product alerts, special offers, updates, and news about World
Book—Mac OS X Edition. To register your copy of World Book
online, choose World Book Registration from the World
Book application menu.

Technical Support*
If you experience any problems using World Book—Mac OS X
Edition, visit the World Book Technical Support Web site
which can be reached by choosing World Book Tech Support
from the World Book application menu or by entering
http://www.mackiev.com/worldbook/support.html in your
Web browser.

Contacting Technical Support

You may contact technical support by email at
macsupport@worldbook.com.  When contacting Technical
Support, please provide this information:

• version of Mac OS X you are running (for example, 10.0.4)

• version of World Book you are using.

Note: The version number is printed on each CD.

• your installed memory (for example, 128 MB RAM)

• your Macintosh type (for example, iMac DV 266 MHz)

• printer type, if any (for example, Epson 740)

• exact text of any error message(s) that appear

http://www.mackiev.com/worldbook/support.html
mailto:macsupport@worldbook.com
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Controls and
Functions

Home Screen

See indicated page(s) for more information.

Search—click once

• Topics*— Search by Topic (p. 4)

• Dictionary* (p. 5)

• Atlas (p. 10)

• Time Frame (p. 11)

• What’s Online (p. 13)

* The current “Monthly Spotlight” article will appear.

Browse—click once

• Just Looking (p. 9)

• Media Center for videos, animations, sounds, etc. (p. 8)

• Monthly Spotlight for timely facts (p. 7)

• Surf the Millennium (p. 14)

Click once

• Update Now to download updates (p. 13)

• Homework Wizards to use the Report, Chart, Timeline,
and Quiz Wizards (p. 15)

• Home Screen Music Settings to turn on or off music
playback on the Home Screen (pop-up menu contains
three choices: Classical, Jazz, and International) and
change the music volume.

Customer Service*
For assistance with questions and inquiries other than

technical support needs, please contact Customer Service
by email at: macsupport@worldbook.com.

* Technical Support and Customer Service may be
discontinued or modified without notice to you.

mailto:macsupport@worldbook.com
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Menu Bar

World Book menu

About World Book: Choose to view product credits and
acknowledgments.

About Surf the Millennium: Choose to view Surf the
Millennium credits and acknowledgments.

Contributors: Choose to view alphabetical lists of World
Book contributors.

Register World Book: Choose to register your copy of World
Book online. Registration allows you to receive special offers,
updates, and news about World Book—Mac OS X Edition.

World Book Speech Technology: Choose to find out about
the development of a Speech Edition of World Book, which
will enable vision-impaired users to access World Book articles
using voice recognition and text-to-speech technologies.

World Book Tech Support: Choose for answers to
Frequently Asked Questions posted on the World Book
Technical Support Web site.

Preferences: On the General tab you can select a default
Internet browser and word processor to launch from World
Book. You also can turn off some special features such as the
water animation effect on maps and the music from the World
Book music collection that plays during startup. On the
Bubble Views tab you can tell World Book whether to show
the Navigation bar for Bubble Views and whether to spin
Bubble Views automatically on opening.

File menu

Save: Choose to save the article in view.
Note that all files are saved in World Book
Notepad format.

Page Setup: Choose to adjust your
printer settings.

Print: Choose Print to open a dialog with
a list of print options such as Entire Article
or Current Section. After selecting the
option(s) you want, click Print. You can
print any of the text in articles and tables
and all of the dictionary entries and maps.
You can also print most of the drawings
and photographs and their captions.

Edit menu

Copy: Choose to copy any currently selected text to the
Clipboard. Text appearing in the following windows can be
selected and copied: Article, Article Update, Caption, Sticky
Note, Table, Dictionary, Month in Brief, and Web Sites. Only
one block of text may be selected at a time in any one
window. You may also copy most pictures, maps, and
illustrations to the clipboard in order to paste them into
layout and word processing programs. To do this, choose
Copy from the Edit menu when a picture or other multimedia
item is in view.

 In the Media Center and Atlas areas you may need to
click the media element once to select it before copying it.

Clear Current Article Highlights: Choose to erase your
highlights from the article in view.

Clear Highlights From All Articles: Choose to erase all
your highlights throughout World Book.

Place Sticky Note: Choose to place an open sticky note into
the currently open article.

Delete Sticky Note: Choose to delete an open sticky note.

Bold Text in Sticky Note: Choose to use bold text in an
open sticky note.

Select All: Choose to select an entire article.

Find: Choose to find a word you want to locate in the article
in view. All instances of the word are located and appear in
red in the Article screen; the screen is initially positioned at
the first instance of the search word. You can also search for
words you’d like to find on any Surf the Millennium pages
that have selectable text.

Find Next: Choose to advance to the next
instance of the search word.

Turn Highlighter On: Choose to turn on the
Highlighter feature. When the Highlighter is on,
this menu item changes to Turn Highlighter Off.

Rotate Highlighter Color: Every time you
choose this option, the Highlighter color will
change between the four available colors:
yellow, pink, blue, and green.

Highlighter Color: Choose to change the
color of highlighting.

Article Text Size: Choose to change the text
size used in the articles.
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Toolbar

The sixteen Toolbar options are displayed in three groups. To
the left of the screen are the Tools icons: Search, Dictionary,
Sticky Notes, Highlighter, and Homework Wizards. In the
center are Navigation Control icons: Back, Forward, Home,
Stop. To the right are the Area icons representing places you
can visit: Article Viewer, Media Center, Just Looking, Atlas,
Time Frame, What’s Online, and Surf the Millennium. The
Toolbar is always available within World Book (except on the
Home Screen), making it easy to move between features and
functions.

Tools icons

There are five Tools icons:

Search: Click for the following capabilities:

Search by Topic: This is the primary search method. Type
your topic in the Enter search words box. Click Go or press
Return to begin the search. The most suitable match will be
highlighted in the search
results list and appears
automatically in the article
display area. If no match
is found for your search
term, a key word search is
automatically performed.
If no match is found in
either the topic or key
word search, an alert
appears. Trying a synonym
for your term may help.
Click the closed file folder
icon next to an item in the
search results list to see
the available subtopics.

Search by Word: At the
top of the window that
appears, click the type(s) of media you want to locate. “All”
will be selected unless you choose otherwise. To refine your
search, use the and/or/not boxes to combine up to three
search terms.

You also can direct the application to search only in certain
text elements and according to the proximity of the terms.
Search always opens to the most recent search performed.

Go menu

Back: Choose to go back one screen at a time.

Forward: Choose to go to the next screen.

Monthly Spotlight: Choose this option for timely
information in the “Spotlight On...” article.

Article Search: Choose to open the Search by Topic or the
Search by Word window, which enables you to search for the
desired article. You can also open it by clicking the Topics icon
on the World Book Home Screen, or the Search icon on the
Toolbar.

Map Search: Click to open the Map Search window, which
enables you to find locations in World Book’s Atlas.

Distance Calculator: Click to open the Distance Calculator
window, which enables you to calculate the distance  between
selected cities.

Surf the Millennium: Choose to surf a millennium’s worth
of simulated Web sites. Online connection required only for
links from this feature to actual Web sites. (Also can be
opened directly from the Home Screen or the Toolbar.)

Tools menu:

Sticky Notes List: Choose to view a list of existing sticky
notes. Double-click a note in the list to go to the article
containing the note; click the note indicator in the article to
open the note. Delete a sticky note by selecting the note in
the list and pressing the Delete key.

History List: Choose to see a list of the last 50 resources you
have used during your current World Book session. Double-
click any item in the list to retrieve it. (The History List is not
saved from session to session.)

Homework Wizards: Choose to select from four
applications designed to help students with common
homework assignments. (Homework Wizards can also be
launched from the Home Screen and the Toolbar.)

World Book Notepad: Choose to paste, type, or edit text
using the World Book Notepad.

Your Word Processor: Choose to open an external word
processor, if one is selected in Preferences.

Dictionary: Choose to look up any word in a World Book
article or any word you type in.  Double-clicking any word in
an article or caption also automatically opens the Dictionary
window.
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Search also can be opened
by choosing Topics from
the Home Screen, or
Article Search from the Go
menu.

Wildcards: You can use
“wildcards” to search for
more than one form of a
word: ? (question mark)
represents a single
character, and * (asterisk)
represents one or more
characters. You may use
wildcards at any place in a
word, but you can only
use one wildcard per
search. Click Go or press
Return to begin the search. Matches will appear in a Wildcard
Word List. To retrieve an item, click it to highlight it, then click
Go. The search term(s) you used will appear in red in the
corresponding articles.

Dictionary: Click the Dictionary icon on the Toolbar, then
enter a word to look up. Click Go or press Return to see a
definition. To display a list of words with similar spelling, click
Word List. The Dictionary window retains the last word
looked up. Click the blue drop-down control to see a list of
words that were looked up during the current session.

 You also can find the meaning of any word in an
article, caption, or dictionary entry simply by double-
clicking the word.

Drag & Drop Tip:  Drag any word from an article, a
Table, or the Dictionary to the Search icon on the toolbar.
The Search window will open and a search will be
automatically performed.

Sticky Notes: Click to create a sticky note. Type the text in
the open sticky note and click the close box to place it.  A
Sticky Note icon will appear. You can edit, delete, place, and
move sticky notes. It is also possible to set any part of the
sticky note in bold text style by selecting the text and then
pressing Command+B. Click the sticky note icon to reopen
a placed sticky note. Drag the icon to reposition the note in
the article.

 To remove a sticky note, open it and choose the Delete
Sticky Note command from the Edit menu.

Highlighter: Click to turn Highlighter mode on or off. Only
article text can be highlighted, but there is no limit to the
number of blocks of text that can be highlighted at a time. A
single word is the smallest element that can be highlighted.
Highlights remain from session to session until you  clear
them. When Highlighter mode is on, the cursor will look like a
marker.

You can select text while holding down the mouse button.
When you have selected all the text you want to highlight,
release the mouse button. You can erase highlights from one
article or all of them by using the Clear Highlights items from
the Edit menu. You can also change the highlighter’s color.
Click the highlighter icon on the Toolbar, hold down the
mouse button and choose the color you want from the drop-
down menu that appears.

 You can erase any highlighting by reselecting the
highlighted portion with the same color highlighter.

You can toggle through the highlighter colors by
pressing Command+Tab on the keyboard.

Homework Wizards: Click to choose from four applications
designed to help students with common homework
assignments.

• Report Wizard for report writing guidance (p. 15).

• Chart Wizard for creating custom charts (p. 15).

• Timeline Wizard for building custom timelines (p. 16).

• Quiz Wizard for making and taking quizzes (p. 17).

You can also select a Homework Wizard from the Toolbar.
Click the Wizards icon and hold down the mouse button to
open the list of Wizards.

Navigation icons

There are four Toolbar icons for navigating in World Book:

.

Back: Click to back up one screen at a time.

Forward: Click to advance one screen, if available.

Home: Click to return to the Home Screen.

Stop: Click to end the feature or function currently in use.
The Stop icon will be enabled when it is available to stop
audio or video playback.
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Area icons

Seven Toolbar icons allow you to quickly move to different
areas of World Book.

Article: Click to go the Article viewer. (p. 7)

Media: Click to go to the Media Center. (p. 8)

Just Looking: Click to use Just Looking. (p. 9)

Atlas: Click to go to the map viewing area. (p. 10)

Time Frame: Click to make a chronological search using the
Time Frame feature. (p. 11)

What’s Online: Click to explore online features. (p. 13)

Surf the Millennium: Click to view simulated Web sites
covering the past 1000 years. (p. 14)
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Article
The Article area of World Book is where you view articles,
related information (on the CD-ROM or online), and media
thumbnails, such as those for pictures and videos. You get to
the Article screen from the Home Screen when you choose
Monthly Spotlight from Browse, or Topics or Dictionary
from Search. When you want to go to the Article screen from
other areas of World Book, click the Article icon in the
Toolbar or click the Go to Article button, if available.

Note: “Thumbnails” are mentioned in the Article, Just
Looking, and Time Frame sections of this User Guide.
Thumbnails are small text or media windows that appear in
the onscreen displays. You can click the thumbnails to go to
the corresponding material.

 To identify material represented by thumbnails, pass
your cursor over the thumbnails and read the text that
appears in the Status Area at the bottom of the window.

Article Functions

Tables: Tables are opened by clicking the Tables
icon when present; tables appear in the Table
Viewer. Most tables preserve their headings as you scroll.

 If you select and copy a table, it can be pasted into a
spreadsheet. Its table format will be maintained.

Click Footnotes to toggle footnotes on and off; click Go to
Article to go to the article associated with the table; click
Enlarge/Reduce Table to fit the window/reduce to default
size.

Audio: Click this icon when it appears to hear
related sounds.

Timeline: Click this icon when it appears to view a
related chronology.

Toggle between Banner View and Compact View tabs in the
Timeline window to select Compact (vertical) or Banner
(horizontal) Timeline version.

Drag & Drop Tip:  Use drag and drop to copy any
Timeline into TextEdit or the World Book Notepad.

Sticky Note: Click this icon when it appears in an
article to view the related sticky note.

Media Thumbnail: Click any small image to move to the
Media Viewer for an expanded view of the image.

Article Outline: Click this button to see a window with
article contents by headings, which will appear in the
window at the left of the screen. Click any item in the
outline, and the article will automatically scroll to that
section. When you scroll the article, the outline scrolls in
tandem with it.

 You can jump to the full-size version of any picture,
map, movie, animation or bubble view, by double-clicking
its icon in the Outline window.

Related Info: CD-ROM: Click this button for a list of related
World Book articles. Double-click any article title to open the
article.

Related Info: Online: Click this button for a list of related
World Book online resources including Web sites selected by
World Book editors. These resources are listed by category,
and are described in the What’s Online section of this manual
(p. 13): Back in Time, Special Reports, Web Sites, and Article
Updates.

Article Media canister: Click this control to
unroll a “filmstrip” showing all media elements
related to the article in view.

Click any item in the filmstrip to move to the section of the
article containing the corresponding thumbnail, or double-
click any item to open it directly. Click the media control or
the tab at the end of the filmstrip to retract the filmstrip.
When the filmstrip is extended, click the left and right icon
arrows to move the filmstrip up/down one picture at a time. If
an article does not contain any media, this control will appear
dimmed.

Monthly Spotlight: The “Spotlight On...” article appears
when you choose Monthly Spotlight from the Home Screen
or from the Go menu. “Spotlight On...” is an article for you to
browse; it changes automatically each month (online
connection not required) with highlights from World Book
and interesting facts about the month.

 Keyboard navigation: You can use your keyboard to
navigate in the Article area:

• Page Up/Page Down—up or down one screen

• Up Arrow/Down Arrow—up or down one line

• Home/End—to beginning or end of the article
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Media Center
All videos, animations, pictures, and Bubble Views appear in
the Media Center.

Media Center Functions

Reduce/Enlarge Image: Click to reduce/enlarge a video or
animation.

Instructions: Click for tips on using World Book media.

Caption: Click to display/hide caption. Caption text can be
selected and copied to the clipboard.

Go to Article: Click to go to the article associated with the
media element in use.

Browse Media: Click to open the Browse Media window.

• Click the Current tab to browse all the media
associated with the article in view before you moved
to the Media Center, or the current Time Frame or
Just Looking search.

• Click All Disc 1 or All Disc 2 tabs to browse all the media
on the specified disc.

Overlays: Click to use any overlays available for the media
element in use. The button will be dimmed if no overlays
are available.

Controls: Click Instructions for guidance in using all types of
World Book media. Here are a few general pointers:

• Sound controls: Clicking a sound icon retrieves a sound;
click Stop in the Toolbar to
stop the audio playback.

• Picture series slider: Series of pictures will be
accompanied by a sequence slider bar showing the total
number of pictures in the sequence and the number of
the picture in view.

• Video controls: To stop a video while it’s playing, click
anywhere inside the video area or click the Stop icon on
the Toolbar. Drag the slider to advance or rewind the
video, or use the arrow buttons to the right of the slider
to go forward or backward frame by frame.

 You can click and drag any frame of a World Book
video onto an open document that accepts graphics to
copy it there.

• Bubble View controls: Click inside the bubble view and
drag the cursor to navigate, or use the compass point
controls on the navigation bar below the bubble view
area. Click the magnifying glass buttons to zoom in or
out. If you see a green window outline, click inside it
to jump to a new view. If you get to the bottom of the
bubble view, you will see a  Reset View graphic; click it
to return to the initial viewpoint.

 Zoom in or out of a bubble view by pressing the + or –
keys on your keyboard.

Disc 2:  A blue "2" identifies material contained on
disc 2. An onscreen prompt will appear when it is
necessary to exchange discs to retrieve the material
you want.

Media Drag and Drop

You can use the drag and drop functionality built into the
Macintosh operating system to copy most media elements.
In general, you use drag and drop by clicking a media
element and dragging it to an open window in a document
that accepts graphics such as TextEdit or the World Book
Notepad.

Movies and animations: You can use drag and drop to copy
any frame of a World Book video or animation. Use the arrow
buttons at the end of the video control bar to select the frame
you want to copy.

Pictures: You can use drag and drop to copy all photos and
illustrations in the World Book media collection, but a few
pictures, including some paintings, cannot be copied. If a
painting cannot be copied you will see that the Edit menu
remains dimmed when you click the painting.

Bubble views and sounds: Drag and drop does not work
for bubble views or sounds, though you can use drag and
drop to copy a picture with a sound icon in it. The sound
icon will appear in the copied picture, but will not function.
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Just Looking
Just Looking enables you to browse through the content of
World Book for ideas, a bit like “flipping through the pages” of
the paper edition. But Just Looking is also a powerful tool for
searching for graphics and articles by category and by media
and document type.

Just Looking Functions

Random: Click to view a sampling of text and media
thumbnails. Make selections from the Content and
Categories menus to tailor the results. For example, you
could select the Category of History and set the Content
type as Sounds and get a random selection of famous
historical speeches. Then change History to Life Science and
get a random selection of animal sounds.

Search: Use the entry field to find a topic by typing the first
few letters and then selecting it from the alphabetical list that
appears.

All Content: Click to focus your Just Looking search by
choosing from:

• Animations

• Articles

• Atlas

• Back in Time

• Bubble Views

• Media

• Pictures

• Sounds

• Special Reports

• Timelines

• Videos

All Categories: Click to focus your Just Looking search by
choosing from:

• Geography

• History

• Humanities

• Industry/Tech

• Life Science

• Phys.Sci/Math

• Recreation

• Social Science

Clear: Click to remove all thumbnails from the viewing area.

Audio icons: Two types of audio features are available in
Just Looking.

Listen Now icon:  The first type of icon, the Listen Now icon,
appears as a square gray button in the upper left
corner of some text thumbnails. The sound
attached to this type of icon may be played

without leaving Just Looking simply by clicking directly on the
icon. If instead you click the text in the thumbnail, you will be
taken to the Media Center and the sound will automatically
start playing there.

Embedded Sound icon: The second type of icon,
an Embedded Sound icon, appears as a white
rectangle embedded in one of the corners of a
picture thumbnail. The sounds attached to these
icons may be played only in the Media Center. Click

anywhere on the thumbnail once to go to the Media Center
where you will see a full-size version of the media element.
You must then click the embedded icon to hear the sound.

Disc2: This symbol identifies material contained on
Disc 2.

 To identify the material represented by thumbnails,
pass the cursor over the thumbnails and read the text at the
bottom of the window.
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Atlas
Atlas opens with an introductory welcome to the feature and
a map of the world. Begin your review of World Book maps by
clicking any continent label; then continue clicking to view
progressively more detailed maps to learn about countries,
states, provinces, or cities. (Also, Atlas can be opened from the
Home Screen.)

Atlas Functions

Map Search: Click to open the Map Search window. Type
the location you want to find in the text entry box, or click a
location in the map list. As you type, the list automatically
repositions itself to entries corresponding to what you type.
Click an item in the list or complete typing the location and
press Return.

Zoom Out: Click to move to progressively larger scale maps
containing the originally selected map.

Overlays: Click the blue Overlays control to open a list of
overlays which may consist of some or all of the following
options:

• Political (selected until you make a choice)

• Population density

• Climate

• Average January temperatures

• Average July temperatures

• Average yearly precipitation

• Agriculture and Fishing

• Mining and Manufacturing

• Terrain

• Economy

Click an overlay to select it and view the map with the
corresponding information. (Not all overlays are active for all
maps.) Once you select Overlays, either a thumbnail locator
map, or a legend appears in the Overlays window to provide
a global point of reference for the selected map.

Go to Article: Click to move to the article associated with
the map in view.

Hotspots: Map hotspots are identified by a change in
the cursor icon from an arrow to either a magnifying
glass, article, or hand icon as you move the cursor over
a map. Click the hotspot to retrieve a related map,
article, or photo.

When the cursor icon changes to a magnifying glass
containing a plus sign, click to reveal a more detailed map.

Drag & Drop Tip:  You can use drag and drop to copy all
of the maps in the World Book Atlas to an open document
window of any application that accepts graphics, such as
TextEdit or the World Book Notepad.

Drag & Drop Tip:  You can drag a place name from an
article or caption to the Atlas icon on the toolbar to start a
map search.  The closest match will appear.

Distance Calculator

The Distance Calculator allows you to find out how far apart
selected cities are. Click the Distance Calculator button on
the main Atlas area to open the Distance Calculator window,
and start typing the name of the first location. A drop-down
list appears from which you can select the name of the city
or location when it appears.

Click the city in the list or press Return. Then press the Tab
key, enter the name of the second city, select it, and press
Return. The globe will spin to show both locations, and a red
line linking them will appear on the small flat map. Distance
Calculator also displays the exact latitude and longitude of
the locations.

Clear: You can use the Clear button to clear the location
names and type new ones.

Go to Map: Click to view the map corresponding to the
location in the Location entry field.

 You can spin the globe by placing your cursor close to
an edge. The globe will rotate away from your cursor.

You can determine the latitude or longitude of any
location on the globe: Clear the Location 1 field if it has a
location typed into it, and then move your cursor over the
place you have in mind. The latitude and longitude will
appear beneath the Location 1 field.
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Time Frame
Use Time Frame to locate information related to a specific
year, decade, century, millennium, or era. Time Frame results
are customized according to choices you make. Some
articles contain Timelines which have been specially
prepared to supplement the articles.

Time Frame Functions

Time Frame allows you two methods of searching: by Time
Period or by Era.  When searching by Time Period, you enter
a specific Time Frame measured in years, decades, centuries,
or millennia.  You may customize a Time Period search by
selecting a Category.  When searching by Era, you select
from one of the preset eras such as The Cold War or The
American Revolution.

Searching by Time Period

Enter a year in the Time Frame device.  Then choose one of
the following from the Time Period pop-up menu:

• Year

• Decade (10 years)

• Century (100 years)

• Millennium (1,000 years)

and specify whether A.D. (selected until you make a choice)
or B.C. If you select a period other than Year after typing a
date, the date will be reset to reflect the selected time
period. (For example, if you type 1952 and then select
Decade, the date will be reset to 1950.)

Use the scroll arrows to move forward or back in time by
increments corresponding to the time period selected. (For
example, if Decade is selected, you will move by periods of
10 years when using the scroll arrows.)

To focus your search, select a Category:

• Geography

• History

• Humanities

• Industry/Tech

• Life Science

• Phys.Sci/Math

• Recreation

• Social Science

Click Go or press Return to begin your search.

Searching by Era

Select Era from the Time Period pop-up menu on the Time
Frame device and then click the blue Era control.  Select an
era from the pop-up menu that appears:

• Aegean cultures: 3000 - 1200 B.C.

• Age of Reason: 1600’s - 1700’s

• American Civil War: 1861 - 1865

• American Revolution: 1775 - 1783

• Ancient Egypt: 3100 - 1070 B.C.

• Ancient Greece: 800 - 338 B.C.

• Ancient Persia: 550 - 331 B.C.

• Ancient Rome: 509 B.C. - A.D. 476

• Byzantine Empire: A.D. 395 - 1453

• Cold War: 1940’s - about 1990

• European Exploration: 1400 - 1890

• French Revolution: 1789 - 1799

• Indians of Latin America: to 1532

• Industrial Revolution: 1700 - 1900

• Medieval Europe: 400’s - 1500’s

• Mesopotamia: 3500 - 539 B.C.

• Mongol Empire: 1100’s - 1294

• Prehistoric animals: to 3500 B.C.

• Prehistoric people: to 3500 B.C.

• Reformation: 1517 - late 1500’s

• Renaissance: 1300 - 1600

• Romantic movement: 1700’s - 1800’s

• Soviet Union: 1917 - 1991

• Space age: 1957 - today

• World War I: 1914 - 1918

• World War II: 1939 - 1945

Click Go or press Return to begin your search.

Viewing Search Results

The search results for both Time Period and Era searches are
displayed as thumbnails in the Time Frame viewing area
under a banner showing the specifications of your search.
Click any thumbnail to go to the corresponding article or
media element.  Pass your cursor over the thumbnails to
view a description of the thumbnail's subject in the Status
Area at the bottom of the screen. Note that dates within the
time period you used in a Time Period search will appear in
red in the resulting articles.



Audio icons

Two types of audio features are available in Time Frame.

Listen Now icon: The first type of icon, the Listen
Now icon, appears as a square gray button in the
upper left corner of some text thumbnails. The

sound attached to this type of icon may be played without
leaving Time Frame simply by clicking directly on the icon. If
instead you click the text in the thumbnail, you will be taken
to the Media Center and the sound will automatically start
playing there.

Embedded Sound icon: The second
type of icon, an Embedded Sound
icon, appears as a white rectangle
embedded in one of the corners of a
picture thumbnail. The sounds
attached to these icons may be played
only in the Media Center. Click
anywhere on the thumbnail once to go

to the Media Center where you will see a full-size version of
the media element. You must then click the embedded icon
to hear the sound.

 Disc 2

This symbol identifies material contained on Disc 2.

New Time Frame

Click to retrieve the Time Frame      
device to perform another search.
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What’s Online
All of World Book's rich online functionality can be accessed
from the What’s Online area, with timely information and
updates that may be downloaded from the Internet. Access to
these updates keeps your World Book current.

What’s Online Functions

Update Now: Clicking the Update Now icon
automatically downloads any available World Book
monthly updates which contain Article Updates,

Month In Brief news events, and any new or updated Web
sites that have become available. A sheet will drop down with
a progress bar to show the status of the download.

Article Updates: Click for a list of World Book
updates that have been posted since the World
Book—Mac OS X Edition was published. Double-
click any Article Update to view it in the Article area.

Month in Brief: Click for a calendar with
summaries of the major news events of each day of
the month. Click a date on the calendar to view

stories for that date. Click the blue right/left arrows on the
calendar to move one month at a time, or jump to a different
time period by using the drop-down month and year menus.

The up and down arrow keys can be used to scroll
through the events displayed in Month In Brief.

Drag & Drop Tip: You can use drag and drop to copy
any news event picture from Month In Brief into an
application that accepts graphics such as TextEdit or the
World Book Notepad.

Web Sites: Click to search a database of Web sites
reviewed and approved by World Book editors. Enter
search terms in the entry fields (for example, Apple
and Computer) and press Return to start the search. Click any
underlined Web site in the results list.

Back in Time: Click to search the World Book
archives of historical articles. Double-click a topic to
start retrieving the Back In Time article. A sheet will

drop down with a progress bar to show the status of the
download. When the download is complete, the article will
be displayed in the Article viewing area.

Special Reports: Click to browse the World Book
Special Reports collection, written by World Book
editors. Browse through the list of reports that
appears or narrow the list by selecting a Category. Double-
click a report to start retrieving it. A sheet will drop down
with a progress bar to show the status of the download.
When the download is complete, the article will be displayed
in the Article viewing area.

World Book on the Web: Click to go directly to
the World Book Web site where you will find

educational resources for parents, students, and teachers.
Your Web browser will be launched when you click the World
Book on the Web icon, and the Home Page of the World
Book Web site will be displayed.

Note:  World Book takes no responsibility for the content or
practices, including usage fees, if any, for any Web sites
operated by independent organizations.



Surf  the Millennium
Surf the Millennium is an imaginative and
historically accurate look at the past 1,000 years,
presented as if the Internet had existed when

Sundiata, the Lion King of Mali, founded his empire; a
broken-hearted shah built the Taj Mahal; and a determined
Florence Nightingale changed the face of modern medicine.
Each century, from the 1000’s to the 1900’s, has its own
home page that links to other imaginary Web sites from that
period. Users access the feature with an offline Web browser
built into World Book.

Choose Surf the Millennium from the World Book Home
Screen or click the Surf icon on the Toolbar for a
millennium’s worth of simulated Web sites. Check out what
some Web news sites might have been like if the Web had
existed throughout the last millennium.

Surf the Millennium Functions

Choose a century from the Surf the Millennium Home
Screen to open a century home page full of features such as
e-zines, want ads, bookstores, and other types of pretend
Web sites.

View from 2000: Although the Surf the
Millennium Web sites are fanciful, the material
they contain is based on fact. Use the View
from 2000 button when it is available to learn what we now
know or think about a featured event, person, or idea, and to
get links to articles, book lists, and actual Web sites.

 Drag & Drop Tip: To view the real story, select and drag
any historical name or place (for example, Joan of Arc) to
the Search icon on the Toolbar. The corresponding World
Book article will appear in the Article viewer.

You can print all of the Web pages in Surf the Millennium by
selecting Print from the File menu. You may also copy any of
the selectable text in Surf the Millennium and paste it into a
word processor such as TextEdit or the World Book Notepad.

 Use the Forward and Back icons on the Toolbar to
browse through the pages you've already visited.
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Homework Wizards
The four Homework Wizards applications are
designed to engage students in doing research
and writing reports, and using their computers

and World Book creatively. Onscreen prompts enable the
student to concentrate on the task rather than on navigating
the software. To get started, click the Homework Wizards
icon on the Home Screen or on the Toolbar, or select
Homework Wizards from the Tools menu.

Report Wizard

The Report Wizard provides guidance in all aspects of report
writing: selecting a topic; preparing a schedule; doing
research and preparing notecards; choosing an approach;
writing a thesis statement; sorting notecards; writing an
outline; writing the first draft; creating visuals; revising;
preparing a bibliography; preparing the final paper.

The first choice you have in the Report Wizard window is
between New Report and Existing Report. If you choose
New Report, you’ll see a Save File sheet asking for a report
name. Entering the report name allows the application to
automatically save all your work. The Report Wizard Menu
appears next. Click any item in the Report Wizard Menu to
do that step. A check mark next to a step shows that you’ve
already completed it for an Existing Report, but you can
return to it to make changes to your work.

Whenever you click Print in Report Wizard, you’ll see a
menu of items such as Blank Notecards from which to
choose. You may also choose to print helpful pointers about
that step in the report writing process. Click Next or Back at
the bottom of Report Wizard windows to complete a choice
and continue or to return to the previous step. Click Done
to leave the step you are working on.

Step 1: In the Select a Topic window, click No if you want
to type a topic you’ve already chosen, or click Yes to get
some help in choosing a topic.

Step 2: The Make a Schedule window contains a calendar
in which you can set a due date for each part of your project.
Use the arrows at either side of the month to move forward
and backward by month in the calendar.

Step 3: When you choose Do Research and click Go to
World Book, the Report Wizard automatically searches World
Book for information related to your topic and retrieves the
most relevant article.

Step 4: In the Choose an Approach window, you choose
from a list of different approaches for presenting the material
in your report and get advice on the various options.

Step 5: In the Write a Thesis Statement window, you see
some sample thesis statements reflecting the Approach you
chose, and can type in your own thesis statement. (If you
didn’t choose an Approach, the program will display
Descriptive thesis statements.)

Step 6: In the Sort Your Notecards window, there is
advice on how to sort the notecards you create during your
research.

Step 7: In the Write an Outline window, there is advice on
writing an outline for the approach you’ve chosen and an
area to prepare your outline. Press Tab to indent a line in
your outline; press Return to move down one line.

Step 8: In the Write Your First Draft window, you create a
file for your first draft. You’ll then begin working with your
word processor, but the Report Wizard will continue to
deliver advice.

Step 9: From the Create Visuals window, you can go to the
Chart or Timeline Wizards. See below for more information
about these Wizards.

Step 10: In the Revise Your Paper window, you can print a
checklist of items to review in your report.

Step 11: In the Create a Bibliography window, you can
prepare a bibliography.

Step 12: In the Prepare Your Final Paper window, you can
print advice on how to format and finish your report.

Chart Wizard

The Chart Wizard enables you to quickly and easily create
and print a chart or graph or add a chart or graph to a report
or presentation. Using Chart Wizard you can create
horizontal bar and vertical bar charts, line graphs, and pie
charts. Click Next or Back at the bottom of Chart Wizard
windows to complete a choice and continue or to return to
the previous step.
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The first choice you have in the Chart Wizard window is
between New Chart and Existing Chart. If you choose.
Existing Chart, you’ll see a sheet asking for a chart name. The
Choose a Chart Type window appears next. Click the type of
chart you want to create.

In the Choose a Comparison window, click the type of
comparison you want to use in your chart. Click Other to
enter a comparison different from those listed in the
window.

In the Select Unit of Measurement window, you see units
of measure appropriate for the type of comparison you
chose. Click a unit of measure.  If you chose Quantity as your
type of comparison, the program will skip this window and
take you directly to the Comparison Table window. If you
chose Other, a window appears in which you can specify
what you are comparing and the unit of measure to be used.
Use the pop-up menu for suggestions of units of measure, or
type a different one.

In the Comparison Table window, you use a two-column
table to enter the labels and amounts that will appear in your
chart. The unit of measure you selected will be shown in the
column on the right. Use the Sort buttons to arrange the
items in alphabetical or reverse alphabetical order, or
ascending or descending order.

In the Chart Title window, you see your chart for the first
time. Use the text entry box to change the chart title if you
wish.

In the Font window, there is a pop-up list of the fonts
available for the text in your chart.

In the Color or Pattern Selection window, you can choose
the colors and patterns for the different segments of your
chart. Click either the Colors or Patterns radio button to
choose colors or patterns. To change the color or pattern of
a segment in your chart, first click the chart segment, then
click the color or pattern you want for that segment.

In the Final View window, you see your completed chart.
Click Save and follow the prompts to choose a folder, name
the file, and save it. The Chart Wizard creates a picture file
(.PICT) that can be inserted into reports or presentations.
The Chart Wizard also creates a Chart Table that allows you
to edit the chart from within the Chart Wizard.

Drag & Drop Tip: You can use drag and drop to copy
your completed chart or graph to an open document
window in any application that can accept graphics such as
TextEdit or the World Book Notepad.

Timeline Wizard

The Timeline Wizard enables you to quickly and easily create
and print a Timeline or add a Timeline to a report or
presentation. The Timelines you create can contain events
and dates you specify or events and dates found in a special
World Book events database. Click Next or Back at the
bottom of Timeline Wizard windows to complete a choice
and continue or to return to the previous step.

The first choice you have in the Timeline Wizard is between
New Timeline and Existing Timeline.  If you choose Existing
Timeline, you will see a sheet asking for a Timeline name
and file location. The Timeline View window appears next.
Choose between Banner and Compact styles.

Note that the Timeline Wizard creates a picture file you can
paste into other documents only for Compact Timelines.
Both banner and compact timelines can be copied directly
into your report, however, using drag and drop.

Drag & Drop Tip:  You can use drag and drop to copy
your completed compact or banner Timeline to an open
document window in any application that can accept
graphics such as TextEdit or the World Book Notepad.

The Enter Events window contains a table you can use to
enter events and dates for your Timeline.

 Use the Tab key to advance from element to element in
each row and use Shift+Tab to go back.

You can get instructions on filling in all the elements of the
events table by clicking the Instructions button. Then select
an element from the pop-up menu at the top of the
Instructions window to view instructions about it.

 Click any element in the event table before clicking the
Instructions button and the Instructions window will open
to show instructions about that element.

You can delete an event by clicking the row number of the
event and then clicking the Delete Event button.

When you click Search in the Enter Events window, a Search
for Timeline Events window appears. Enter search words,
combining them as desired using the pop-up menu, and
click Go to search a special World Book database of events.
To select an item from the Results box for your Timeline,
click it to highlight it, then click Select Events. To select all
the items in the Results box, click Select All.
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Quiz Wizard

The Quiz Wizard enables you to make and take three
different types of quizzes to challenge yourself just for the
fun of it or to practice for quizzes and tests you take in
school.

You can make true/false and flash card quizzes on any
subject, or create mathematics quizzes. Use the Advice
buttons that appear in some of the Quiz Wizard windows for
tips on how to get the most out of a particular Quiz Wizard
feature. Use the Print button to print out whole quizzes
(questions and answers; questions only; answers only),
individual question and answer, Advice screens, or Quiz
Score screens.

Make or Modify Quiz

The first choice you have in the Quiz Wizard window is
between Make or Modify Quiz and Take Quiz. If you choose
Make or Modify Quiz, a window will appear where you can
choose between New Quiz and Existing Quiz.

If you choose New Quiz — meaning that you want to make
a new quiz — the Save File sheet will appear. Entering the
quiz name allows the program to save all your work
automatically. Then go to the Choose Quiz Format window
and pick True/False, Flash Card, or Mathematics. After you
choose a format, you’ll go to the Quiz Manager window for
the type of quiz you’ve selected.

 When making mathematics quizzes, you can use your
mouse to click numbers in an onscreen calculator keypad,
or you can use the number keys on your computer
keyboard.

If you choose Existing Quiz — meaning you want to make
changes to a quiz you’ve made before — you’ll choose the
filename of the quiz you want. You’ll then go to the Quiz
Manager window for that quiz.

There are Advice, Quiz Manager, and Question/Answer Entry
windows for each of the three types of quizzes. Advice gives
you some pointers in using the type of quiz you’ve selected.
Quiz Manager enables you to make, change, or delete items
for new and existing quizzes.

When you choose to make or change a quiz item, you’ll go
to a Question/Answer Entry window that will take you
through the steps to make or change an item. Deletions are
made from within the Quiz Manager window. Items in an
existing quiz will be listed in the Quiz Manager window.

When you take a quiz you’ve made, you’ll be shown all the
items you created in that quiz. Keep this in mind when
you’re making quizzes, and create only as many items as
you’ll want to be quizzed on. When you’ve made all the
items you want in a quiz, click Done. You’ll then have the
option to take the quiz right away. If you decide not to take
the quiz, then you may make another one or quit Quiz Wizard.

Take Quiz

If you choose Take Quiz, a sheet will open, from which you
can select an existing quiz. After you select a quiz, an
introduction appears showing the number of items in the
quiz and the steps to follow in taking that particular type of
quiz. You’ll then move on to the quiz items, one by one.
Click Next to find out if your answer is correct, and to move
on to the next quiz item.

You have two chances to complete each quiz item correctly
in the flash card and mathematics quizzes; in true/false
quizzes there’s naturally only one chance. When your answer
is correct, simply click OK to go to the next item. If your
answer is incorrect, you can try again or choose to see the
correct answer. You also can skip any item in the quiz you’re
taking. The quiz items will appear in random order instead
of the order in which you entered them.

You will see your score after you have done all the items in a
quiz. You can repeat the quiz right away, simply review all
the items in the quiz, or quit the Quiz Wizard.

Click Select Events and then OK to add the list of events
you’ve selected to your Timeline. Then click Next and your
Timeline appears in the Change the Title or Font window.
You can change the Timeline title if you wish and select a
new font from the pop-up font list.

In the Add a Picture window, click Pictures for a scrollable
list of picture descriptions. Select a picture description to see
a preview of the picture. Click OK to attach the selected
picture to the Timeline title.

In the Final View window, you can see your completed
Timeline. Click Save and follow the prompts to choose a
folder, name the file, and save it.  For Compact style
Timelines, Timeline Wizard creates a Timeline Picture File
that can be inserted into reports or presentations. The
Timeline Wizard also creates a Timeline Table File that allows
you to edit the Timeline from within the Timeline Wizard. If
you want to create another Timeline click New Timeline.
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